
◊ Introduction

MorseTrainer is a tool for learning and training Morse code. This help text describes the most important
parts of the program. Use the popup-menu above to scroll to a specific section. If you think that this 
text is difficult to read you can print it out.

◊ Installation

MorseTrainer does not require any special installation procedure. The program can be used on a 
diskette, harddisk or file server. If you copy the program don't forget to copy the library file as well if 
any. When MorseTrainer is used for the first time on your computer it will automatically create a 
preference file in the system folder. This file is used for saving your settings when you quit 
MorseTrainer. If the file is moved or deleted a new file will be created containing default settings.

§ To be able to use MorseTrainer system version 6.0.7 or later must be installed. If you have system 
version 7.0 or later you will have access to help balloons.

◊ General

MorseTrainer is primarily intended for training of listening but can of course also be used for transmit 
training. You can choose between three different types of training using the popup-menu in the 
MorseTrainer window.

• User Text
• Random Text
• Lesson Texts

User text means that you train with text entered by yourself or text read from a file (from the File 
menu). Random Text means that the program creates a new text with random characters every time 
you start training. Which characters to use and how long the words should be can be set in the 
Random Text dialog box. Finally you can choose to train with lesson texts from a library. These texts 
should be designed with increasing difficulty and tempo making the training as effective as possible. If 
you are a true beginner you are recommended to start with this kind of texts.

◊ MorseTrainer window

This is the main window where the training actually takes place. The topmost part of the window is a 
message area in which you are informed about what is happening. The part below the message area 
contains buttons for starting and stopping the training and check boxes to control if and when the 
training text should be visible. Furthermore it contains the popup-menu from which you select the type
of training that you want and a column list for the lesson texts within the selected library section. The 
text used when training can be shown in this window.

◊ Alphabet window

All the characters defined in the selected Morse alphabet is shown in this window. Clicking on a 
character makes the program signal the character. You can also use the keyboard. You can select an 
alphabet from the Settings menu.
 

◊ Apple menu



About MorseTrainer… displays a dialog box containing general information about MorseTrainer. Simply 
click in the dialog to make it disappear.
Help… displays this window. You can also access this window from the Windows menu.

◊ File menu

The Close command topmost in the File menu is simply used for closing/hiding the frontmost window. 
Of course, the close box of the windows can be used as well. A hidden window is displayed by using 
the windows menu.

When User Text training is selected it is possible to enter your own text with the keyboard or use text 
from a text file. The latter is done by using the Read Text File command from the File menu.

∆ When a text is read from a file is replaces the old text completely.

The contents in all windows can be printed expect for the Clipboard window. Use the Page Setup 
command to set your printer options and the Print command to actually print the contents of the 
frontmost window. When choosing Print for the training window only text will be printed. Each window 
has its own page setup. Finally, last in the File menu is the Quit command. When quitting the program 
will save your settings in the preference file until the next time you use MorseTrainer again.

◊ Edit menu

This menu contains the usual commands associated with text editing. The work in all windows and 
dialogs having editable text areas. Besides theses commands it is possible access the Clipboard 
window from this menu as an alternative to the Windows menu.

◊ Settings menu

Select the Tempo & Speed dialog box to change the speed of the signalling. We refer to tempo as the 
actual number of characters being sent per minute (using the PARIS standard). The speed stands for 
the speed of the characters themselves. That is, the characters are played as fast as given by the 
speed but if the tempo is lower the time distance between each character and word will be increased.

This is simply a trick used by beginners to prevent them from counting long (dah) and short (dit) 
signals. Furthermore, you can choose if you want the settings in this dialog box to be applied on the 
lesson texts or not (otherwise the lesson texts have their own tempo and speed settings). If you 
choose to couple speed to tempo you only need to change the tempo. The speed and tempo will be 
related such that if the tempo is below 60 characters per minute the speed will increase when the 
tempo is decreased and if the tempo is 60 or more the speed becomes equal to the tempo.    

! Tempo and speed can also be specified in words per minute instead of characters per minute by using
the popup-menu next to the tempo control. One word corresponds to 5 characters.

In the Alphabet dialog box you can select what alphabet to use if more than one is available 
(experienced Macintosh users may create their own alphabets using a resource editor). 
Volume, pitch, waveform and risetime of the Morse signal is set in the Sound dialog box. Listen to your 
settings by clicking on the speaker symbol.

Use the Random Text dialog box to specify how random text should be generated. In order to be able 
to train with random texts you must create at least one random character group containing the 
characters that will be used by the random generator. To create a new group enter the characters in 



the text area and click on the Add button.

The contents of a existing group is simply changed by selecting the group in the column list and there 
after change the text field. All the groups are saved in the preference file. The group selected in the list
is the one that is used. The length of the words as well as the number of characters to be generated 
can also be set.

All other settings have been collected in the Miscellaneous dialog which allows you to control:

• The start delay
• The pause delay
• How to act when a new Morse paragraph starts. A new Morse paragraph starts with a line containing 
only a '='-character followed by an empty line.
• If signalling should continue even if MorseTrainer is forced to the background. Usually MorseTrainer 
should cancel the signalling if forced to the background in order to make the sound channel available 
for other applications.
• If you want to be warned about invalid characters before the training starts. While signalling invalid 
characters will be heard as a long signal with a different pitch.
• If you want to listen to the characters introduced in the selected lesson before the training starts.
• If you want to listen to the characters used in the random text before the training starts.
• If you want a sequence of spaces being interpreted as a single space.
• The font to be used in the training window and in the alphabet window.

An indicator is used to show the remaining time of the start and pause delays.

Last in the Settings menu is the Library command which displays a dialog box allowing you to edit the 
current library with lesson texts. You can also select other libraries or create new ones. You can read 
more about libraries below.

◊ Window menu

Use this menu to show a window and make it the frontmost window. The Clipboard window can also be 
accessed from the Edit menu and the Help window from the Apple menu.

◊ How to Edit Libraries

The purpose of libraries is to collect texts specifically designed for effective training of Morse. 
Depending on which country you live in different radio amateur associations may have their own way 
of learning and training Morse. Thus MorseTrainer allows you to build a library with the lesson texts 
that you prefer to train with.

A library is a file which can be placed anywhere: on a harddisk, file server or diskette. Once you have 
selected it in the Library dialog box MorseTrainer will remember its location. When selecting Library 
from the Settings menu the last selected library will be shown. Of no library could be found you will be 
asked to select another library or create a new and empty library. A library contains sections with 
lessons. All lessons within a section have the same tempo and speed.

The idea is to start learning the characters in one section having a low tempo and high speed where a 
couple of new characters are introduced in every or almost every lesson. Thereafter, a new section is 
selected with higher tempo or lessons with higher difficulty.

The dialog box has one column list to the left for the sections and one list for the lessons to the right. If
you select a section its lessons will appear in the lessons list. The name of the selected section and the
corresponding tempo and speed can be changed below the list.



A new and empty section is created with the New button and an existing section and all its lessons can
be deleted with Delete button. Another feature which is valid for both lists is that the items can be 
moved (up or down). The order in the lists are reflected in the popup-menu and the column list in the 
training window.

The name of a selected lesson can be changed as well as the characters being introduced in that 
lesson (if any). These characters can be presented to the user before the training starts. For the 
lessons not introducing any new characters this field should be empty.

To add a new lesson    to the selected section use the New button. A dialog will be displayed which will 
allow you to select a text file containing the text of interest (this means that you cannot enter lesson 
texts directly in MorseTrainer). You are free to use any word processor or text editor to create such a 
text file. As for the sections the lessons can be deleted as well as moved up and down.

The first time MorseTrainer is used it will look for a library file in the same folder as MorseTrainer. If a 
library is found it will automatically be selected. If not, use the Library command to select a library or 
create a new.

◊ Training Morse

You may think that listen to Morse means counting short and long signals which you translate to 
characters. This is definitely not the case. A skilled Morse listener instead hears the "melody" of each 
character. In order to prevent you from counting short and long signals every character can be 
signalled with high speed but with a low tempo to give you time to think.

As a beginner you should start to train with ready-made texts especially designed for learning. Such 
texts are not a part of MorseTrainer because different ideas about learning Morse exists and therefore 
we encourage you to make your own library.
You could start with a tempo of 30 characters per minute and a character speed of 60 characters per 
minute or more. When you have learned all the characters and you feel comfortable with the current 
tempo then increase the tempo. 

When you are done with all the lessons you can start to train with texts of your own or random texts. 
Random texts have one advantage. You cannot figure out what the next character will be.

∆ When learning and training Morse you should always keep the texts hidden using the appropriate 
check boxes in the MorseTrainer window. When signalling and the text is visible each character being 
signalled will be marked. This feature is for demonstration purposes only.

§ If you only want to listen to a part of a text you can select that text or place the insertion point just 
before to first character to be signalled.

For more information about Morse code contact your local radio amateur association.

◊ Miscellaneous

If several programs are used at the same time generating sound they must share the sound generator 
in your computer. Because of this several programs cannot in general play sounds simultaneously. 
Therefore, the general rule is that the programs being forces to the background should leave the sound
channels to the program being frontmost. This means that MorseTrainer automatically will stop the 
signalling if forced to the background. However, as described above this feature can be turned off.

If you have system version 7.0 or later installed to you will have access to the help balloons in 
MorseTrainer describing menus, dialogs and windows. Sometimes, these balloons says more than this 
help text!



◊ Licence
Even though MorseTrainer has been tested under different conditions in order to obtain good 
performance the author disclaims all responsibility for damages caused by using MorseTrainer.
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